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La série des articles sur LibreOffice continue…

Dans ce numéro spécial, le volume Deux, nous continuons le collation-
nement des tutoriels LibreOffice écrits par Elmer Perry.
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d'une suite ininterrompue d'articles. Mais ne vous inquiétez pas, rien ne
manque : Elmer a pris des vacances pour deux ou trois numéros.

Veuillez garder à l'esprit la date de publication originale ; les versions
actuelles du matériel et des logiciels peuvent être différentes de celles
illustrées. Il convient donc de vérifier la version de votre matériel et de
vos logiciels avant d'essayer d'émuler les tutoriels dans ces numéros
spéciaux. Il se peut que les logiciels que vous avez installés soient plus
récents ou qu'il y ait des versions plus récentes disponibles dans les
dépôts de votre distribution.
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C
alc est le module tableur ou
feuille de calcul de LibreOf-
fice ; il est compatible avec
Excel de Microsoft. Nous avons

déjà vu une façon d'utiliser Calc quand,
dans mon dernier article, nous avons
créé notre base de données primitive,
mais Calc peut faire beaucoup plus
que la collecte de données. Comme
son nom l'indique, Calc peut faire des
calculs avec de très nombreuses
fonctions intégrées au program-
me. Cela veut dire que nous ne
sommes pas obligés de calculer
la somme des entrées dans une
colonne à la main ; nous pouvons
insérer une formule qui fera l'ad-
dition à notre place. Calc vous
permet de créer un scénario « Et
si… » et jouer avec les chiffres
dans votre classeur.

Avant de commencer la cons-
truction de notre classeur Budget,
vous avez besoin de connaître cer-
taines choses sur comment un fichier,
parfois appelé un classeur dans Calc,
fonctionne. Chaque fichier peut conte-
nir plusieurs feuilles de calcul diffé-
rentes. Dans un nouveau classeur,
vous avez par défaut trois feuilles de
calcul, appelées Feuille1, Feuille2 et

Feuille3. Leur nom figure sur des
onglets en bas de la fenêtre. Chaque
feuille est composée de cellules indi-
viduelles, identifiées par la lettre de
leur colonne et le numéro de leur
ligne. Par exemple, la première cellule
en haut et à gauche est A1, la pre-
mière colonne, la première ligne.
Chaque feuille peut avoir jusqu'à
1 024 colonnes et 1 048 576 lignes.

La disposition d'une fenêtre Calc
est quelque peu différente de celle
d'une fenêtre Writer. Il y a toujours
une barre standard et une barre de
formatage, mais en dessous de celle-

ci, vous verrez la barre de formule.
Cette barre est votre amie quand
vous travaillez dans Calc. La case tout
à fait à gauche indique le nom de la
cellule actuelle. Elle vous dit quelle
cellule, ou groupe de cellules, est
sélectionné à un moment donné. Les
trois icônes immédiatement à droite
de cette case sont l'assistant fonc-
tions, le bouton somme et le bouton

fonction. Encore à droite, vous
verrez la ligne de saisie que vous
devez utiliser pour modifier le
contenu d'une cellule.

En haut de la feuille, vous
avez les en-têtes de colonne (A,
B, C…) et, le long du côté
gauche, les en-têtes de ligne (1,
2, 3…). Les colonnes et les
lignes sont matérialisées sur la
feuille par des lignes gris clair.
Cette grille sera utile lors de la
conception de votre feuille de
calcul.

Il y a plusieurs façons de saisir des
données dans une cellule. Vous pou-
vez cliquer dessus et commencer à
taper. Quand vous avez terminé, ap-
puyez sur Entrée et vous vous retrou-
verez dans la cellule en dessous. Vous

pouvez aussi cliquer sur une cellule et
entrer les données dans la ligne de
saisie de la barre de formule. Cette
méthode a un inconvénient que j'ex-
pliquerai dans une minute, mais, par-
fois, c'est la meilleure façon de modi-
fier le contenu d'une cellule. Vous
pouvez aussi l'éditer dans la cellule,
en double-cliquant dessus, ce qui vous
met en mode édition. Modifier une
cellule dans ce mode est similaire à
son édition dans la barre de formule.

La navigation à l'intérieur de votre
feuille peut se faire à la souris : il suffit
de cliquer sur la cellule que vous sou-
haitez. Cependant, puisque vos doigts
sont souvent déjà sur le clavier, les
raccourcis clavier fonctionnent mieux.
La touche de tabulation (Tab) vous
met dans la cellule immédiatement à
droite de celle où vous vous trouviez.
Maj+Tab vous met dans la cellule
immédiatement à gauche. Appuyez
sur Entrée et vous serez dans la
cellule en dessous de celle où vous
étiez et, avec Maj+Entrée, vous serez
au-dessus. Si vous n'êtes pas en mode
édition, ni en train d'utiliser la ligne de
saisie, les touches fléchées vous
déplaceront dans la direction de la
flèche. Les touches fléchées sont désac-
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tivées pour la navigation si vous êtes
dans la ligne de saisie, ou en mode
édition, pour vous permettre de bou-
ger à l'intérieur du contenu.

Cela étant, avec ces quelques
outils à votre disposition, nous allons
construire la première section de
notre feuille de calcul Budget. Ouvrez
un nouveau fichier Calc. Cliquez sur
l'endroit vierge et gris à gauche de
l'en-tête de colonne et au-dessus de
l'en-tête de la première ligne. Vous
sélectionnerez ainsi toute la feuille.
Dans la barre de formatage, réglez la
police à une jolie police sans-serif
comme Arial et la taille de la police à
12 points. En faisant ceci, nous venons
de régler la police et la taille de police
par défaut pour la feuille entière.

Dans la cellule A1, entrez le texte
« Revenu pour cette période » et ap-
puyez sur Entrée. Pour le moment, ne
vous inquiétez pas si le texte dépasse

les limites de la cellule. On va remé-
dier à cela dans un instant. Sur la
deuxième ligne de la colonne A, tapez
« Sources ». Toujours dans la colonne
A, sur les lignes suivantes, tapez vos
différentes sortes de revenu comme,
par exemple Salaire, Free-lance, Prime.
J'ai l'habitude d'ajouter un « Divers »
pour les trucs qui ne correspondent
aux autres catégories, comme gagner
le gros lot ou démissionner.

Maintenant, certaines de vos sour-
ces de revenu dépasseront peut-être
de leurs cellules. Nous pouvons ajus-
ter la largeur de la colonne en cli-
quant entre les en-têtes de cellule
pour A et B et en déplaçant la bor-
dure. La cellule A1 ne nous intéresse
toujours pas. À ce stade, le dépas-

sement du texte dans A1 est OK ; il
s'agit ici de vous assurer que toutes
vos sources de revenu se trouvent bien

à l'intérieur des limites de la colonne.

Placez-vous en cellule B2. Tapez
« Montant ». Appuyez sur Entrée. En
descendant la colonne B, tapez un
montant pour chacune des sources
de revenu. Vous remarquerez que,
par défaut, les nombres ne sont pas
formatés. Nous allons les faire res-
sembler à des montants en monnaie.
Nous les changerons tous en même
temps. Vous pouvez sélectionner toutes
les cellules contenant des nombres
en cliquant avec le bouton de gauche
de la souris et en glissant vers le bas
jusqu'à ce que tous les nombres soient
mis en surbrillance. Vous pouvez aussi
cliquer sur la première cellule, appuyer
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sur la touche Maj en la tenant en-
foncée et cliquer sur la dernière. En
vous servant du clavier, utilisez Maj
avec les touches fléchées. Format >
Cellules > Nombres. Choisissez la caté-
gorie Monétaire. Dans le menu dé-
roulant au-dessus de la boîte format,
sélectionnez la monnaie de votre pays.
Sélectionnez un format monétaire dans
la boîte des formats. C'est vraiment à
vous de choisir. Étant donné que vous
ne devriez jamais avoir un chiffre
négatif dans les cellules de vos reve-
nus, vous n'avez pas besoin de vous
préoccuper trop des formats pour les
nombres négatifs.

Nous allons maintenant nous oc-
cuper du contenu de la cellule A1 qui
continue dans B1. Puisque ce texte
est le titre de la section, nous voulons
qu'il couvre la largeur de la section. La
solution est de fusionner les cellules.
Mettez les cellules A1 et B1 en sur-
brillance, puis Format > Fusionner les
cellules > Centrer les cellules. Nous
allons beaucoup nous servir de Fusion-
ner les cellules et il deviendra sans
doute l'une des fonctionnalités de
formatage que vous préférerez. Mal-
heureusement, il n'y a pas de rac-
courci clavier. Vous pouvez en créer
un dans Outils > Personnaliser… >
Clavier, mais assurez-vous de ne pas
choisir un raccourci clavier pour une
fonctionnalité usuelle ou prédéfinie.

Maintenant, donnons-lui l'apparence
d'un en-tête, en réglant la police en
gras, Format > Cellules > onglet
Police. Sous Style, choisissez gras.
Rajoutons une bordure autour pour le
démarquer un peu plus du reste.
Cliquez sur l'onglet Bordures. Sous
Par défaut, cliquez sur la deuxième
case, Définir les quatre bordures. Lais-
sez Style tel quel, mais modifiez la
couleur en gris. Cliquez sur OK.

Pour ce qui concerne nos en-têtes
Sources et Montant, nous voulons les
démarquer aussi, mais d'une façon
différente pour les différentier de
l'en-tête de section. Sélectionnez les
deux cellules qui contiennent Sources
et Montant. Format > Cellules > onglet
Police. Sélectionnez gras à nouveau.
Cliquez sur l'onglet Bordures. Cette
fois-ci, nous ne voulons qu'une bor-
dure entre les deux cellules. Dans la
case Défini par l'utilisateur, cliquez
entre les deux boîtes grises qui con-
tiennent un X blanc. Vous verrez une
ligne entre les deux. Modifiez la cou-
leur en gris. Sous l'onglet Alignement,
réglez l'alignement horizontal en
« centre » et le vertical en « milieu ».
Sous l'onglet Arrière-plan choisissez un
bleu clair (Bleu 8) pour la couleur de
l'arrière-plan. Cliquez sur OK.

On pourrait mettre une bordure
autour des sources de revenu, mais

cela peut parfois devenir difficile à
lire. À la place, nous allons changer la
couleur de l'arrière-plan des lignes
paires. Commencez avec la deuxième
source, sélectionnez et le nom et le
montant. Format > Cellules > onglet
Arrière-plan. Choisissez un gris clair

pour l'arrière-plan. J'ai choisi Gris 10
%. Cliquez sur OK et faites la même
chose pour toutes les lignes paires.

Ce serait bien d'avoir un sépa-
rateur entre la source et le montant
et une bordure autour de la liste
complète. Cliquez sur la première
source, en appuyant sur Maj, cliquez
sur le dernier montant. Ainsi toutes
les sources et tous les montants
seront mis en surbrillance. Format >
Cellules > onglet Bordures. Sous Par
défaut, choisissez la deuxième case,
Ne définir que la bordure extérieure.
Vous remarquerez que la case Défini
par l'utilisateur a changé. Il y a main-
tenant quatre carrés gris contenant
des X blancs. Cliquez entre les deux

carrés du dessus. Vous obtiendrez
ainsi une ligne verticale entre les
cellules. Un clic au milieu créerait une
ligne verticale et une ligne hori-
zontale, ce que nous ne voulons pas.
Changez la couleur en gris et cliquez
sur OK.

Et voilà : la section Revenu de
notre Feuille de calcul est terminée.
Dans le prochain article, nous allons
continuer notre feuille de calcul Bud-
get en ajoutant la section Actifs. Et
nous allons examiner la façon de
demander à la Feuille de calcul de
faire des maths pour nous au moyen
de la fonction Somme.

http://eeperry.wordpress.com
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Dans la partie 8, nous avons
étudié le formatage des cel-
lules de notre tableur pour
qu'elles apparaissent d'une

certaine manière. Cependant, la véritable
puissance de Calc vient de sa capacité à
calculer des formules en utilisant des ma-
thématiques de base et de ses fonctions
intégrées. Les formules Calc sont juste ce
à quoi vous pensez : des expressions ma-
thématiques qui utilisent les données
pour créer un résultat. Les fonctions Calc
nous offrent des calculs prédéfinis et des
prises de décision. Avec juste un peu de
connaissances sur les formules et les fonc-
tions, Calc devient un puissant outil d'ana-
lyse de données. Lorsque vous entrez
une formule ou une fonction dans une
cellule, votre formule ou fonction doit
commencer par les signes = (égal), -
(moins)ou+(plus).

Opérateursarithmétiques

Calc a cinq opérateurs arithmétiques
debase:
+ (Plus) : pour additionner deux nombres
ou comme signe d'un nombre. Ex. =2+5
ou+5.
- (Moins) : pour soustraire un nombre d'un
autre ou rendre un nombre négatif. Ex.
=5-2ou-5.

* (Astérisque) : opérateur de la multiplica-
tion.Ex.=2*3.
/ (Slash) : opérateur de la division. Ex.
=21/7.
^ (Accent circonflexe) : opérateur de l'ex-
posant.Ex.=5^2.

Tout comme dans les vraies mathé-
matiques, vous pouvez utiliser des paren-
thèses pour regrouper des expressions
afin de créer des formules plus compli-
quées. Par exemple, si vous entrez dans
une cellule l'équation =5-2*3, lorsque
vous appuierez sur la touche Entrée, vous
obtiendrez -1 comme résultat. Toutefois,
si vous entrez dans une cellule l'équation
=(5-2)*3, vous obtiendrez 9 comme résul-
tat lorsque vous appuierez sur la touche
Entrée. Cela arrive parce que Calc obéit
aux règles de priorité. Dans la première
équation, la multiplication se fait d'abord,
selon les règles, ce qui nous donne 5-6, ce
qui équivaut à -1. Dans la deuxième équa-
tion, nous changeons l'ordre des opéra-
tions en utilisant des parenthèses. Dans
ce cas, 5-2 est d'abord calculé dans les
parenthèses, nous obtenons 3, et 3 x 3
équivautà9.

Référencesdescellules

Écrire en dur nos nombres n'a pas

beaucoup de sens. Nous pourrions sim-
plement utiliser une calculatrice pour ce-
la. Pour libérer la puissance des capacités
de calcul de Calc, une référence aux don-
nées de notre feuille de calcul est néces-
saire. Les références de cellule nous
permettent d'utiliser les données de
notre feuille de calcul dans nos calculs.
Les cellules sont référencées par la lettre
de la colonne et le numéro de la ligne. La
première cellule de la première colonne
est A1, la deuxième cellule de la première
colonne est A2, la première cellule de la
deuxième colonne est B1, la deuxième
cellule de la deuxième colonne est B2,
etc. Si nous entrons 5 dans la cellule A1 et
6 dans la cellule B1, nous pourrons entrer
l'équation =A1+B1 dans n'importe quelle
autre cellule dans le tableur, et le résultat
affichésera11.

Dans certaines fonctions, vous aurez
besoin de faire référence à une plage de
cellules plutôt qu'à des cellules indivi-
duelles. Pour faire référence à une plage
de cellules, commencez par la première
cellule suivi de deux points (:) et enfin la
dernière cellule de la plage. Pour accéder
aux 9 premiers éléments de la colonne B,
utilisez B1:B9. Pour accéder aux 5 pre-
miers éléments de la ligne 1, utiliser
A1:E1.

Que faire si vous devez faire ré-
férence à plusieurs lignes et colonnes ?
Vous avez juste à commencer par la pre-
mière cellule du bloc et à terminer par la
dernière cellule. Par exemple, pour faire
référence à toutes les cellules des 5 pre-
mières lignes et colonnes, vous devriez
utiliserA1:E5.

Fonctionsmathématiques

Si vous avez besoin de la somme
d'une colonne de nombres, utiliser des
opérateurs mathématiques de base
pourrait très vite devenir laborieux. Calc
propose de nombreuses fonctions pour
des opérations mathématiques, comme
calculer la somme des cellules données
ou encore les fonctions trigonomé-
triques. Ces fonctions accéléreront votre
usagedesformules.

SOMME() est la base de fonctions
mathématiques. Très souvent utilisée,
elle a son propre bouton sur la barre de
fonctions. SOMME() peut prendre jusqu'à
30 nombres ou références de cellules
entre parenthèses. Vous pouvez égale-
ment utiliser les références d'une plage
avec SOMME(), ce qui vous permet d'ob-
tenir rapidement le total d'une colonne,
d'une ligne ou d'une plage de lignes et de
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colonnes. Plusieurs nombres, références
de cellules ou plages de cellules sont sé-
parésparunpoint-virgule(;).

ExemplesdeSOMME()

=SOMME(A1;C2;D5) : somme des trois
cellules.

=SOMME(2;A1;C5) : somme du chiffre 2,
A1etC5.

=SOMME(A1:A5) : somme des cinq pre-
mièrescellulesdelacolonneA.

=SOMME(A1:B5) : somme des cinq pre-
mièrescellulesdescolonnesAetB.

=SOMME(A1:A5;C1:C5) : somme des cinq
premièrescellulesdescolonnesAetC.

Calc propose de nombreuses autres
fonctions mathématiques. Consultez la
documentation de LibreOffice Calc pour
une liste complète, y compris les fonc-
tionstrigonométriques.

Calculsaveccondition

Parfois, vous ne voulez effectuer un
calcul que lorsque certaines conditions
sont remplies. Un bon exemple pour illus-
trer cela est d'éviter une division par zéro.
Si vous essayez de diviser par zéro, vous
obtiendrez une erreur. La fonction condi-

tionnelle SI() nous aide à accomplir cela.
La syntaxe de base du SI() est : SI
(test;alors_valeur;sinon_valeur).

Ainsi, si nous voulons diviser A1 par
B2 et que nous voulons éviter l'opération
si B2 est égal à zéro, nous pourrions utili-
serlafonctionSI() :

=SI(B2>0;A1/B2;”division par zéro im-
possible”).

Celasetraduitpar :SiB2estsupérieur
à 0, alors diviser A1 par B2 ; sinon afficher
letexte«divisionparzéroimpossible».

Les calculs conditionnels peuvent
vous aider à éviter les erreurs dans vos
feuilles de calcul. Utilisez-les dès que vous
pensez qu'un problème pourrait surgir,
comme la division par zéro ou lorsqu'un
nombren'apasétéentré.

Opérateursdecomparai-
son

Calc propose six opérateurs de com-
paraison que nous pouvons utiliser dans
notretest.
=(égalà)
>(supérieurà)
<(inférieurà)
>=(supérieurouégalà)
<=(inférieurouégalà)
<>(différentde)

En plus des opérateurs de comparai-

son, nous pouvons utiliser les fonctions
NON() et ET() dans notre test. Le ET()
permet de tester plus d'une condition et
NON() l'inverse de la condition. Cette fois,
faisons en sorte qu'aucun des nombres
nesoitégalà0:

=SI(ET(NON(A1=0);NON(B2=0));A1/B

2;”division par zéro impossi

ble”).

Dans cette formule, nous nous assu-
rons que A1 n'est pas nul et que B2 n'est
pas nul avant d'effectuer notre calcul.
Bien que cette formule utilise à la fois les
fonctions ET() et NON(), une formule plus
pratiqueauraitété:

=SI(ET(A1>0;B2>0);A1/B2;”divi

sion par zéro impossible”).

Nous avons seulement commencé à
entrevoir les possibilités de Calc en utili-
sant ses formules et ses fonctions. La
prochaine fois, nous jeterons un coup
d'oeil à quelques utilisations pratiques de
certainesdecesfonctions.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.

Le Podcast Ubuntu couvre toutes les
dernières nouvelles et les problèmes
auxquels sont confrontés les utilisa-
teurs de Linux Ubuntu et les fans du lo-
giciel libre en général. La séance
s'adresse aussi bien au nouvel utilisa-
teur qu'au plus ancien codeur. Nos dis-
cussions portent sur le développement
d'Ubuntu, mais ne sont pas trop tech-
niques. Nous avons la chance d'avoir
quelques supers invités, qui viennent
nous parler directement des derniers
développements passionnants sur les-
quels ils travaillent, de telle façon que
nous pouvons tous comprendre ! Nous
parlons aussi de la communauté Ubun-
tuetdesonactualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est couvert
par le Code de Conduite Ubuntu et est
doncadaptéàtous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise) et
est disponible au téléchargement le
joursuivant.

podcast.ubuntu-uk.org

http://podcast.ubuntu-uk.org/
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Dans la partie 8 de cette sé-
rie, nous avons débuté no-
tre travail dans Calc et
avons créé et mis en for-

me une section Revenu pour une
feuille de calcul Budget. Le mois dernier,
nous avons commencé notre discus-
sion des fonctions et des formules.
Dans cette partie, nous allons conti-
nuer à travailler sur notre feuille de
calcul Budget et utiliser des formules
et des fonctions pour y faire des calculs.

Configuration de la
section Actifs

Si vous vous souvenez, nous avions
mis en place une section contenant
tous les éléments de nos revenus
dans les colonnes A et B. Nous allons
commencer notre section Actifs dans
la cellule D1. Déplacez-vous vers cette
cellule et entrez-y « Actifs ». Sélec-
tionnez les cellules D1-G1, fusionnez

et centrez les cellules (Format > Fu-
sionner les cellules > Fusionner et
centrer les cellules). Dans la cellule
D2, entrez « Type ». Fusionnez et
centrez cette cellule avec E2. Entrez
«  Début » et « Fin » dans, respec-
tivement, les cellules F2 et G2. Dans la
cellule D3, entrez « Total des recettes
pour la période » et fusionnez-la avec
la cellule E3 (Format > Cellules Fusion-
ner > Fusionner les cellules). Dans les
lignes D4-D9, entrez dans l'ordre le
texte suivant : Solde compte chèques,
Transfert épargne, Total disponible,
Solde épargne, Solde retraite, Actifs
bruts. Après avoir entré le texte dans
les cellules, fusionnez ces cellules avec
la cellule adjacente de la colonne E
(c'est-à-dire fusionnez D4 avec E4, D5
avec E5, etc.).

Calcul initial pour la
section Actifs

Dans la cellule F3, nous placerons
notre premier calcul en utilisant la
fonction SOMME(). Pour cette cellule,
nous devons additionner les nombres
de la colonne B dans notre section
Revenu. Entrez cette formule dans la
cellule F3 :

=SOMME(B3:B6)

Cette formule utilise la fonction
SOMME() pour additionner les nom-
bres entrés dans les cellules B3, B4,
B5 et B6. Si votre section Revenu con-
tient plus ou moins d'éléments de reve-
nus, réglez la référence des cellules
donnée à la fonction SOMME(). Si
vous sortez une calculatrice et entrez
les nombres, vous obtiendrez le même
résultat calculé par LibreOffice Calc.

Dans les cellules F4 et F5, saisissez
les montants pour Solde compte chè-
ques et Transfert épargne. Dans la
cellule F6, nous aurons besoin de faire
la somme des trois montants ci-

dessus pour l'élément Total
disponible, mais cette fois,
nous utiliserons une méthode

différente. Sélectionnez la cellule F6
et cliquez sur le bouton somme (à
gauche) de la barre de formule. Vous
remarquerez que LibreOffice trouve
automatiquement les trois montants
ci-dessus et crée une formule de la

fonction SOMME() avec la plage. Ap-
puyezsurEntréepouraccepter laplage.

Entrez les montants pour Solde
épargne et Solde retraite dans les cel-
lules F7 et F8. Sélectionnez la cellule
F9 et cliquez sur le bouton somme
dans la barre de formule. Notez que,
une fois de plus, Calc a sélectionné les
deux nombres au-dessus, mais pour
un total exact des actifs bruts, nous
avons besoin d'inclure le montant to-
tal disponible. Cliquez à gauche et faites
glisser pour sélectionner les trois cel-

lules. Vous devriez voir maintenant la
plage corrigée dans la fonction SOMME().
Appuyez sur Entrée pour accepter.

Mise en place de la
section Dépenses

Nous reviendrons à la section
Actifs pour faire plus de calculs une
fois que nous aurons mis en place la
section Dépenses. Dans la cellule A11,
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entrez « Dépenses ». Fusionnez et cen-
trez les cellules A11-G11. Dans les cel-
lules A12-E12, entrez le texte suivant :
Type, Exigible, À payer, Payé et Notes.
Fusionnez et centrez les cellules E12-
G12. Cela devient notre en-tête de la
ligne pour cette section.

Dans la cellule A13, entrez « Epar-
gne » et dans la cellule A14, entrez
« Retraite». Cesdeuxdépensesreprésen-
teront les sommes déposées dans ces
deux comptes et nous les utiliserons
dans nos calculs définitifs dans la
section Actifs. En commençant par la
cellule A15 et en descendant dans la
colonne A, entrez les autres dépenses
comme la nourriture, le carburant, les
hypothèques, le téléphone, etc. Dans
les colonnes B et C, entrez les dates
d'échéance et les montants dus pour
tous les éléments que vous avez en-
trés dans la section Dépenses. Choi-
sissez quelques éléments et mettez
le montant des paiements dans la co-
lonne D. Fusionnez les colonnes E, F
et G pour chacun des éléments.

Formules dans la section
Dépenses

Dans la cellule située sous le der-
nier élément (colonne A), entrez « Dé-
penses totales : » et fusionnez-la avec
la colonne B sur cette ligne. Sélec-
tionnez la cellule dans la colonne C

pour cette ligne. Cliquez sur le bou-
ton somme dans la barre de formule.
Calc devrait sélectionner tous les
montants dans la colonne Montant dû.
Appuyez sur Entrée. Dans la colonne
D de la même ligne, entrez « Total
des paiements » et fusionnez-la avec
la colonne E sur la même ligne. Sélec-
tionnez la colonne F de la même ligne
et cliquez sur le bouton somme dans
la barre de formule. Cette fois, Calc
saute tout jusqu'au dernier montant
dans notre section Actifs, ce que nous
ne voulons cependant pas. Cela arrive
parce que c'est le premier nombre
trouvé par Calc dans la colonne.
Sélectionnez les nombres dans la
colonne Payés de la section pour modi-
fier la plage. Appuyez sur Entrée.

Calculs définitifs pour
la section Actifs

Pour en revenir à la section des
Actifs, nous utiliserons quelques nom-
bres de la section Dépenses afin de
faire quelques opérations en plus.
Sélectionnez la cellule G6. Il s'agit du
total de nos revenus disponibles après
que tous les paiements ont été
effectués. Entrez la formule :

=F6-F##
où ## représente le numéro de ligne
où le total des paiements a été

calculé.

Pour le solde de clôture de notre
compte d'épargne, nous avons besoin
de prendre le total initial, d'ajouter la
somme déposée et de soustraire le
transfert. Si vous placez Epargne comme
votre premier élément dans la section
Dépenses, la formule devrait ressem-
bler à ceci :

=F7+D13-F5

Pour le solde de Retraite final,
nous avons juste besoin d'ajouter le
montant déposé. Si vous avez ajouté
Retraite comme deuxième élément dans
la section Dépenses, la formule sera :

=F8+D14

Enfin, nous allons procéder à
l'ajustement fi-
naldesActifsbruts
en additionnant
les trois chiffres
dans la colonne
G. Sélectionnez
G9 et cliquez sur
le bouton somme
dans la barre de
formule. Calc de-
vrait sélection-
ner les trois nom-
bres dont nous
avons besoin.
Appuyez sur

Entrée.

Notre feuille de calcul Budget est
maintenant terminée, mais elle n'est
pas très belle. La prochaine fois, nous
mettrons en forme notre feuille de
calcul en utilisant des styles.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a ajouté
de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix et un grand
bol de Linux et Ubuntu.



spécial libreoffice volume deux 10

Dans la dernière partie de
cette série, nous avons ajou-
té les données et les for-
mulesànotrefeuilledecalcul

Budget. Le résultat final, bien que fonc-
tionnel,n'estnitrès joli,ni facileàlire.Nous
allons maintenant ajouter quelques styles
à notre feuille de calcul afin de la rendre
non seulement plus agréable à l'œil, mais
aussi plus facile à lire et à trouver des don-
nées spécifiques. Nous atteindrons cet ob-
jectifenutilisantdesstylesdecellules.

Nous avons utilisé, dans la partie 3 de
cette série, les styles de paragraphe pour
formater les paragraphes de nos docu-
ments. Les styles de cellule sont les équi-
valents dans Calc des styles de para-
graphe. Les styles de cellule nous per-
mettent de définir la bordure, la police,
l'arrière-plan, les effets de police, le format
numérique, l'alignement et la protection
de cellules. Les styles aident à créer une co-
hérencetoutaulongdelafeuilledecalcul.

Stylesdestitresde
sectionetdecolonne

Nous commencerons par créer des
styles pour nos titres de section et de co-
lonne. Cliquez sur l'icône Styles (ci-contre).

Maintenant, nous allons créer un style
pour les titres de nos colonnes en fonction
du style Section. Baser un style sur un
autre rend rapide et facile l'ajout et la mo-
dification des différences entre les styles.
Dans la fenêtre Styles et formatage, cli-
quez droit sur le style Section et sélection-
nez Nouveau. Nommez le style « Titre
Colonne ». Vous remarquerez que le style
est lié au style Section. Si vous naviguez à
travers les onglets, vous pourrez voir que
tous les paramètres configurés pour le
style Section sont déjà définis. Pour distin-
guer les titres des colonnes de ceux des
sections, nous leur donnerons une couleur
de fond différente. Sous l'onglet Arrière-
plan, sélectionnez une couleur claire ap-
propriéepourlefond,commebleu8.

Application des styles aux

titres de section et de co-
lonne

Nous pouvons à présent appliquer nos
deux nouveaux styles de cellules à notre
feuilledecalcul.Lessectionssont«Revenu
pourlapériode»,«Actifs»et«Dépenses».
Sélectionnez les cellules pour ces
éléments et double-cliquez sur le style
Section dans la fenêtre Styles et forma-
tage. Vous pouvez sélectionner plus d'une
cellule et appliquer le style en une seule
fois. Par exemple, mettez en surbrillance
tous les titres des colonnes sous Revenu
(Sources et Montant) et double-cliquez sur
le style Titre Colonne. Faites de même
pour les titres des colonnes dans les deux
autressections.

Styles Modifiable, Total et
Date

Les éléments modifiables sont les
éléments dans notre feuille de calcul Bud-
get que nous aurons besoin de changer à
chaque utilisation. Ce sont la plupart des
cellules sous le titre des colonnes, sauf
ceux qui contiennent des formules qui
sont nos cellules de total. Nous créerons
d'abordlestyleModifiableetnousl'utilise-
rons comme lien pour les styles Total et

Date.

Dans la fenêtre Styles et formatage,
cliquez droit sur le style par défaut et
sélectionnez Nouveau. Nommez le nou-
veau style « Modifiable ». Sous l'onglet
Nombres, sélectionnez Monnaie et votre
format monétaire. Réglez votre police et

sa taille sous l'onglet Police. Je suggère
unetailledepoliced'au moins12. Assurez-
vous que le style de police est régulier (ni
gras ni italique). Sous l'onglet Bordures,
créez une ombre de bordures grises pro-
jetée sur la gauche et la droite. Vous pou-
vezréaliserceciencliquantsurlatroisième
zone sous Par défaut. Sous l'onglet Pro-
tection de cellules, assurez-vous que la
caseProtégéestdécochée.

Nous allons, à présent, créer le style
TotalenleliantaustyleModifiable.Cliquez
droitsurlestyleModifiabledanslafenêtre
Styles et formatage, puis sélectionnez
Nouveau. Encore une fois, nous commen-

TTUUTTOORRIIEELL
Écrit par Elmer Perry

LLiibbrreeOOffffiiccee -- PPaarrttiiee 1111
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çons avec une copie exacte du style sur le-
quel nous avons fait un clic-droit. Nommez
le style « Total ». Nous apporterons des
modifications pour distinguer nos totaux
des éléments ordinaires. Sous l'onglet Po-
lice, modifiez le style pour mettre en gras.
Sous l'onglet Arrière-plan, sélectionnez
une couleur plus foncée que le gris clair
déjà utilisé pour les bordures, comme le
gris ou le gris 40 %. Enfin, cochez la case
Protégé sous l'onglet Protection de
cellule.

Appliquez les styles comme nous
l'avons fait précédemment. Vous remar-
querezquesivousappliquezlestyleModi-
fiableàlacolonneDatesouslesFrais,vous
obtiendrez un résultat étrange pour vos
dates (probablement ####). En fait, elles
ont été converties au format monétaire.
Cliquez droit sur le style Modifiable et
créez un nouveau style nommé « Dates ».
Tout ce que nous avons à faire ici est de
changer la catégorie à Date et sélection-
nez un simple format de date numérique
sousl'ongletNombres.

Formatageconditionnel

Nous avons besoin d'un moyen de
morceler le gros bloc de données dans la
section Dépenses. Nous pourrions simple-
ment mettre des bordures autour d'elles,
si ce n'est que de grands groupes de blocs
avec des bordures paraîtraient ternes.
Nous mettrons plutôt en évidence toutes
les lignes paires avec un gris clair. Nous
voulons aussi le faire rapidement. Pour ce-
la, nousutiliserons leformatagecondition-
nel.

EST.PAIR(LIGNE())

Avec cette formule, quel que soit le
style que nous choisissons, il ne sera appli-
qué qu'aux lignes paires. Pour le style de
cellule, cliquez sur le bouton Nouveau
style,nommezlestyle«ModifiableenSur-
brillance » et liez-le au style Modifiable.
Sous l'onglet Bordures, changez la couleur
delaborduredugrisclairaugris.Allezsous
l'onglet Arrière-plan et changez la couleur
defondàgrisclair.CliquezsurOKpouren-
registrer les modifications. Vous remar-
querez que le style de cellule est
maintenant Modifiable en Surbrillance. Cli-
quez sur OK et vous verrez que les lignes
pairessontmisensurbrillanceengrisclair.

Malheureusement, cela a pour effet
secondaire de modifier nos dates à nou-
veau, mais cela est facilement corrigeable
en faisant la même chose avec le style
Date.Sélectionneztouteslesdatesdansla
section Dépenses. Format > Formatage
conditionnel. Une fois de plus, utilisez la
formule EST.PAIR (LIGNE()). Cliquez sur le
bouton Nouveau style, nommez le style
« Dates en Surbrillance » et liez-le au style
Dates.Changezlacouleurdelabordureau
griset l'arrière-planaugrisclair.CliquezOK
pour enregistrer le style, puis sur OK pour
appliquerleformatageconditionnel.

Touchefinale

Juste quelques petites choses simples
pour que tout soit bien. Si vous avez plus
de deux éléments dans la section Revenu,
vous pouvez ajouter la surbrillance en utili-
sant aussi bien le formatage conditionnel
que le style Modifiable en Surbrillance. En
outre, vous pouvez aligner à droite les la-
bels « Total Dépenses » et « Total Paie-
ments»situésplusbas.

Testez à présent votre feuille de calcul.
Rappelez-vous, nous avons protégé les
cellulesquenousnevoulionspasmodifier.
Outils > Protéger le document > Feuille.

Vous pouvez entrer un mot
de passe pour protéger le
document ou cliquez sim-
plement sur OK pour le

protéger sans mot de passe. Si vous es-
sayez de modifier l'une des cellules proté-
gées,vousobtiendrezunefenêtreavecun
message annonçant que la cellule est pro-
tégée. Cependant, les cellules non proté-
gées restent facilement modifiables,
comme avant. Utiliser la protection des
cellules est un bon moyen de préserver
vos formules du changement une fois que
la feuille de calcul est en place et qu'elle
fonctionnecommevoulu.

Danslaprochainepartiedecettesérie,
nous préparerons notre feuille de calcul
pourl'impressionenajoutantunen-têteet
un pied de page. Nous examinerons éga-
lementlesoptionsd'impression.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
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Dans mon dernier article, j'ai
traité la configuration des
styles dans LibreOffice Calc. Ce
mois-ci, je vous montrerai com-

ment préparer, vérifier et imprimer votre
feuille de calcul. Nous ajouterons des en-
têtes et pieds de page à notre feuille,
nous utiliserons l'Aperçu avant impression
pour vérifier à quoi ressemblera notre
feuille une fois imprimée et nous examinerons
la boîte de dialogue d'impression et
comment elle affecte l'impression finale.

Renommer des feuilles

Lorsque vous créez une nouvelle feuille
de calcul, le classeur par défaut com-
mence par trois feuilles nommées Feuille1,
Feuille2 et Feuille3. Vous pouvez utiliser
ces noms dans d'autres endroits dans
votre feuille et nous les utiliserons lorsque
nous créerons l'en-tête et le pied de page
pour notre feuille de calcul Budget.
Toutefois, les noms par défaut ne sont pas
très parlants et nous allons donc les
renommer. Les noms se trouvent sur les
onglets de la fenêtre du programme, en
bas. Pour renommer une feuille, faites un
clic droit sur l'onglet Feuille et sélectionnez
Renommer la feuille dans le menu dérou-
lant. La boîte de dialogue Renommer la
feuille s'affiche. Écrivez un nom significatif

pour la feuille, comme « 24 février 2012 »
et cliquez sur OK.

En-têtes et pieds de page

Les en-têtes et les pieds de page nous
permettent de créer de la cohérence
entre les pages. Faire cela directement sur
la feuille provoquerait un mélange des
cellules compte tenu des changements et
de l'évolution de la feuille. En utilisant les

paramètres de page, nous pouvons créer
la même apparence pour de nombreuses
pages.

Ouvrez la boîte de dialogue des para-
mètres de la page sous Format > Page. Cliquez
sur l'onglet En-tête. Ici, vous pouvez ajus-
ter les marges, la largeur et la hauteur de
la zone d'en-tête. Je recommanderais de
cocher la case Adaptation dynamique de
la hauteur, sinon votre en-tête pourrait
être tronqué. Cliquez sur le bouton Éditer

pour ouvrir la boîte de dialogue Zone de
l'en-tête. Vous remarquerez que l'en-tête
est divisé en trois zones : gauche, centre et
droite. En bas, vous remarquerez une barre
d'outils. La barre d'outils vous permet
d'insérer des espaces réservés dans l'en-
tête et de formater le texte. Pour notre
feuille de calcul Budget, nous placerons
quelque chose dans chacune des zones.
Dans la zone de gauche, écrivez « Budget
2012 ». Dans la zone centrale, nous pla-
cerons le nom de notre feuille. Pour obte-
nir le nom de la feuille, cliquez dans la zone
centre et supprimez tout contenu déjà
présent, puis cliquez sur le troisième bou-
ton sur la barre d'outils. Cela permet
d'insérer le nom que vous avez donné à la
feuille. Pour la zone de droite, nous insé-
rerons la date actuelle. Cliquez dans la zone
de droite et supprimez tout contenu déjà
présent. L'avant-dernier bouton sur la
barre d'outils insère la date actuelle. Pour
modifier la police, la taille, la couleur, etc.
du texte, sélectionnez le texte dans l'une

des zones et cliquez sur le premier bouton
de la barre d'outils. Cela affichera une
boîte de dialogue de police, où vous pour-
rez modifier les attributs du texte. Cliquez
sur le bouton OK lorsque vous avez fini
d'éditer votre en-tête.

Nous voudrions aussi peut-être séparer
notre en-tête du reste de la feuille avec
une bordure ou une couleur de fond. Nous
pouvons le faire en cliquant sur le bouton
Options de l'onglet En-tête dans la boîte
de dialogue Page… Dans mon cas, il s'agit
d'une ligne de 0.50pt en bas.

L'onglet Pied de page est le même
que l'onglet En-tête, mais nous allons
mettre des informations différentes dans
les trois zones. Sous l'onglet Pied de page,
cliquez sur le bouton Éditer. Dans la zone
de gauche, placez le nom de la feuille en
utilisant le troisième bouton sur la barre
d'outils, comme nous l'avons fait dans la
zone centrale de l'en-tête. Dans la zone
centrale, supprimez le contenu déjà pré-
sent et tapez le mot Page et un espace.
Cliquez sur le quatrième bouton de la
barre d'outils. Cela crée un espace réservé
pour le numéro de page. Cet espace ré-
servé sera incrémenté pour chaque page
de la feuille. Dans la zone de droite, cli-
quez sur le dernier bouton de la barre
d'outils pour insérer un espace réservé à
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l'heure actuelle. Ceci affichera l'heure lors-
que vous imprimerez la feuille. Avoir la
date et l'heure sur la feuille peut être
pratique lorsque vous avez à faire des
modifications et que vous avez besoin de
savoir quelle est la plus récente. Comme dans
le cas de l'en-tête, nous pouvons modifier
les attributs du texte en mettant en évidence
le texte que nous voulons changer et en
cliquant sur le premier bouton dans la
barre d'outils. Cliquez sur OK lorsque vous
avez terminé l'édition.

Pour séparer le pied de page du reste
du document, nous pouvons utiliser le
bouton Options pour créer une bordure
ou une couleur de fond. J'ai utilisé une
ligne 0.50 pt en haut.

Dans notre configuration, nous avons
utilisé tous les boutons de la boîte de
dialogue d'édition pour l'en-tête/pied de
page à l'exception de deux. Le deuxième
bouton insère le nom du classeur et le
cinquièmeinsèrelenombretotaldepages.

Nous avons terminé l'édition de la
mise en page. Cliquez sur OK pour fermer
la boîte de dialogue de configuration de la
page.

Aperçu de la page

L'Aperçu de la page permet de faire les
derniers ajustements à notre feuille avant

impression. Avec la prévisualisation, nous
pouvons être sûrs que tout tienne sur la
page de la façon dont nous le voulons et
que les données apparaissent comme nous
l'avionsprévu.

Pour ouvrir l'Aperçu de la page, allez
dans Fichier > Aperçu . La fenêtre en cours
est remplacée par la fenêtre de visua-
lisation de la page. Vous pouvez faire plu-
sieurs ajustements en mode Aperçu.

Le curseur dans la barre d'outils est le
facteur d'échelle. Cela vous permet de
rendre les cellules plus ou moins grandes
de sorte qu'elles tiennent sur la page
comme vous le souhaitez. Vous pouvez
augmenter la taille en cliquant sur le signe
plus (+) ou la réduire en cliquant sur le
signe moins (-). Vous pouvez également
cliqueretfaireglisserlecurseurderéglage.

Le bouton Formater la page affiche la
boîte de dialogue Style de page. Ici, vous
pouvez changer les marges de l'ensemble
de votre page ainsi que la couleur de fond.
Vous pouvez aussi faire des corrections et

des ajustements à vos en-tête et pied de
page. Deux choses que nous n'avons pas
encore mentionnées sont l'alignement du
tableau et l'ordre d'impression. L'alignement
du tableau se trouve sous l'onglet Page. Il
vous permet de centrer le tableau hori-
zontalement, verticalement, ou les deux.
Sous l'onglet Feuille, l'ordre des pages
détermine comment les cellules seront
imprimées sur la page. Cela vous permet
de faire la mise en page de vos données
dans l'ordre et la manière que vous
voulez. Si vous avez plus de colonnes
qu'une page peut contenir, vous pouvez
changer cela de la valeur par défaut à De
gauche vers la droite, puis vers le bas.
Vous pouvez également définir le début
de la numérotation des pages si vous avez
besoin d'une valeur autre que 1. Vous
pouvez également spécifier ce qui sera
imprimé et ce qui ne le sera pas. Enfin,
vous pouvez régler manuellement l'échelle
ici aussi.

Avec l'Aperçu de la page, vous avez des
boutons pour passer à la page suivante ou
précédente, et pour sauter à la première

page ou à la dernière. Il y a aussi un
bouton Zoom avant/arrière pour un
examen plus approfondi de la page.

Le bouton Marges vous donne la pos-
sibilité d'ajuster la page, l'en-tête, le pied
de page et les marges des colonnes. Cli-
quez sur le bouton Marges pour activer le
mode des marges. Les lignes pointillées
vous permettent de régler manuellement
les marges de la page, de l'en-tête et du
pied de page. Les marqueurs noirs en haut
vous permettent d'ajuster la largeur des
colonnes. Cliquez sur le bouton Marges
pour quitter le mode des marges.

Le bouton Fermez l'aperçu vous fait
sortir du mode de prévisualisation.

L'impression

Nous avons enfin terminé toute notre
préparation et il est temps d'imprimer
notre feuille. Fichier > Imprimer affiche la
boîte de dialogue d'impression. Sous l'onglet
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Général, vous pouvez sélectionner votre
imprimante. Cliquez sur le bouton Pro-
priétés pour les réglages spécifiques à
votre imprimante. Vous pouvez choisir d'im-
primer seulement les feuilles sélectionnées,
toutes les feuilles, ou uniquement les cel-
lules sélectionnées. Vous pouvez égale-
ment spécifier si vous souhaitez imprimer
toutes les pages ou seulement des pages
sélectionnées. Si vous n'avez pas envie
d'ordonner vos pages après les avoir impri-
mées, vous pouvez également choisir de
les imprimer dans l'ordre inverse. Vous
avez la possibilité d'imprimer des copies
multiples et de les assembler ou non.

Sous l'onglet LibreOffice Calc, vous
pouvez choisir d'imprimer ou non les pages
vierges. L'onglet Mise en page vous four-
nit des options pour l'impression de plus
d'une page sur une feuille de papier, dans
quel ordre les imprimer et s'il convient de
mettre une bordure autour de la page.
Dans l'onglet Options, vous pouvez choisir
d'imprimer vers un fichier postscript et, si

vous imprimez plusieurs copies, s'il y a lieu
de le faire comme une tâche d'impression
simple ou multiple.

Une fois que vous avez tout configuré,
cliquez sur Imprimer.

Cette démarche peut sembler exces-
sive pour un document unique, mais vous
devez toujours tenir compte du nombre
de fois que vous allez utiliser et modifier le
document. Si vous utilisez fréquemment
une feuille, comme un budget, une fois
l'en-tête et pied de page réglés, vous n'au-
rez plus à les modifier à nouveau. En envi-
sageant la possibilité de réutiliser les ré-
glages, vous diminuez le temps que vous
consacrerez la prochaine fois pour l'utiliser.

Le mois prochain, nous nous penche-
rons sur quelques petits trucs et
astuces pour travailler avec des feuilles
de calcul dans Calc.

TUTORIEL - LIBREOFFICE PARTIE 12

Opinion rapide

Décrochez, abandonnez tout et faites
avancer les choses
par Allan J Smithie

J'ai déconnecté l'Internet aujourd'hui.
Je ne veux pas dire tout l'Internet,
mais plutôt mon accès. J'ai débranché
le routeur du courant.

J'ai aussi tué le processus de mon lecteur
de musique et laissé mon téléphone portable
dans une autre pièce.

Quelque chose de mystique s'est ensuite
produit : laconcentration.

J'aime l'Internet et j'en suis probablement dépendant. C'est une
ressource considérable et incomparable pour l'information, la re-
cherche, l'apprentissage et le divertissement. Cependant, de temps en
temps, je dois l'éteindre complètement afin de m'organiser pour
avancer [Ndt : allusion à la méthode de gestion des priorités décrite
dans le livre éponyme].

Éteignez la télévision, la radio, l'iPod, la Xbox, la PSP et la Wii.
Fermez les navigateurs (les deux) et tuez le processus des salons de
discussion, d'IRC, d'AIM, de Facepunch, de Twiddle et de tout ce qui est
en cours d'exécution. Le « fact checking », lui, peut attendre. Et
contrairement aux systèmes de croyance contemporains, votre statut
ne doit pas être mis à jour en temps réel. Il sera toujours là. Après cela,
quelque chose aura AVANCÉ.
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Jusqu'à présent, nous avons cou-
vert de nombreux sujets sur l'uti-
lisation de Calc de LibreOffice,
mais Calc possède de nombreuses

petites opérations qui sont bonnes à
connaître. Dans cet article, je vais vous
donner mes 10 meilleurs conseils faci-
litant l'utilisation de Calc. La plupart
d'entre eux se rapportent à la manipula-
tion de la feuille en cours. Vous pouvez
utiliser ces conseils dans la plupart des
feuilles avec lesquelles vous travaillez.

1. Nommer les feuilles

Le nom par défaut pour les feuilles
est FeuilleX, où X est un nombre. Vous
avez 3 façons de nommer une feuille. La
première est lorsque vous créez une
nouvelle feuille, en utilisant Insertion >
Feuille… Dans la boîte de dialogue, vous
pouvez déterminer le nom de la feuille.
Vous pouvez également choisir d'insérer

plusieurs feuilles. Lors de l'insertion de
plusieurs feuilles, vous n'avez aucun con-
trôle sur le nom des feuilles. Vous obtien-
drez la convention de nommage par dé-
faut FeuilleX.

De toute façon, vous devrez peut-être
renommer une feuille après qu'elle a été
créée. C'est là que les deuxième et troisième
méthodes s'appliquent. La deuxième façon
de nommer une feuille est en cliquant
droit sur l'onglet de la feuille et en
sélectionnant « Renommer la feuille » à
partir du menu. La boîte de dialogue « Re-
nommer la feuille » apparaîtra, et vous
pourrez changer le nom de la feuille. La
troisième méthode est tout simplement
de double-cliquer sur l'onglet des feuilles.
Ceci nous amène à la boîte de dialogue
« Renommer la feuille », où vous pouvez
changer le nom de la feuille.

NOTE : Le nom de la feuille doit com-
mencer par une lettre ou un chiffre, mais
le reste peut inclure des espaces, des
lettres, des chiffres, des soulignements,
et certains caractères spéciaux, comme -
et &. Lors de l'enregistrement au format
Microsoft Excel, les noms de feuilles ne
peuvent pas contenir les caractères : , \, /,
?, *, [ et ]. Si vous avez un caractère non
valide dans le nom, Calc vous affichera un
message d'erreur.

2. Supprimer des feuilles

Parfois, vous souhaitez supprimer
une ou plusieurs feuilles d'un classeur.
Pour supprimer une feuille, faites un clic
droit sur l'onglet de la feuille et
sélectionnez «  Supprimer la feuille… »
dans le menu, ou sélectionnez « Édition >
Feuille > Supprimer… » de la barre de
menu. Calc vérifiera que vous voulez
réellement supprimer la feuille. Pour
supprimer plusieurs feuilles, maintenez
enfoncée la touche Ctrl tout en cliquant
sur les onglets des feuilles que vous
souhaitez supprimer. Utilisez soit la
méthode par clic droit, soit par le menu
pour supprimer les feuilles. Une fois de
plus, Calc va vérifier que vous souhaitez
supprimer les feuilles.

3. Déplacer/Copier des
feuilles

Parfois, vous avez besoin de réorga-
niser ou copier des feuilles. Par exemple,
lorsque vous souhaitez ranger un classeur
à plusieurs feuilles dans l'ordre d'utili-
sation prédominante, ou par date. Copier
une feuille est très pratique lorsque vous
avez besoin de créer une copie exacte de
la feuille, créant ainsi une feuille histo-
rique. Lorsque vous copiez une feuille,
vous obtenez une copie exacte de la
feuille que vous avez copiée, mais quand
vous apportez des modifications à la
nouvelle feuille, ces changements ne sont
pas reportés dans l'ancienne feuille. Par
exemple, vous pouvez créer une copie
d'une feuille de calcul de budget pour
chaque période de paie de l'année et les
conserver dans un classeur.

Déplacer une feuille peut se faire de
deux manières. La première méthode
consiste à faire glisser l'onglet de la
feuille vers la position que vous voulez.
Les doubles flèches indiquent l'emplace-
ment que la feuille doit occuper une fois
que vous la relâchez. L'autre méthode
consiste à utiliser la boîte de dialogue
« Déplacer/Copier la feuille… ». Vous pou-
vez accéder à ce dialogue en faisant un
clic droit sur l'onglet que vous souhaitez
copier ou déplacer, puis en sélectionnant
« Déplacer/Copier la feuille… », ou par
l'intermédiaire de la barre de menu,
Édition > Feuille > Déplacer/Copier…
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Sous la section Action, vous pouvez
choisir de copier ou de déplacer la feuille
en cours.

REMARQUE : Si vous n'avez qu'une
seule feuille dans votre classeur, les fonc-
tions déplacer et copier seront grisées, et
la copie sera sélectionnée. Dans la
section Vers le document, vous pouvez
choisir de déplacer/copier la feuille dans
le document actuel, dans un autre docu-
ment ouvert ou dans un nouveau docu-
ment. La section Insérer avant contrôle le
placement de la feuille déplacée/copiée.
La feuille se déplace/copie juste une
position avant la feuille sélectionnée. Un
choix spécial ici est «- placer en dernière
position -» (déplacer vers la position
finale). La sélection de ce dernier choix va
déplacer/copier la feuille à la fin de la
liste des feuilles. La section Nom vous per-
met de donner à la feuille un nouveau
nom. Renommer votre feuille est une
bonne idée lors de la copie. Si vous ne lui
donnez pas de nouveau nom, elle conser-
vera le nom actuel et ajoutera un trait de
soulignement et un nombre, par exemple
MaFeuille_2.

4. Onglets de couleur

Les aides visuelles peuvent souvent
permettre de faire avancer les choses
rapidement, tout en travaillant avec un
classeur de grande taille contenant plu-
sieurs feuilles. La couleur est une aide
visuelle facile à mettre en place. Donner
à chaque onglet de la feuille une couleur
différente peut vous aider à le trouver et
vous y rendre rapidement. L'onglet de la
feuille courante est toujours blanc, mais
vous pouvez toujours lui donner une
couleur s'il n'est pas sélectionné. Pour
définir la couleur de l'onglet d'une feuille,
faites un clic droit sur l'onglet et sélec-
tionnez « Couleur d'onglet » dans le
menu. Une boîte de dialogue de couleur
apparaîtra. Sélectionnez simplement la
couleur que vous voulez pour l'onglet et
cliquez sur OK.

5.Figerleslignes/colonnes

Les feuilles longues et larges ont sou-
vent besoin de défilement pour afficher
une partie du contenu dans la feuille.
Mais, dans de nombreux cas, les premières
lignes et colonnes contiennent les infor-
mations dont vous avez besoin pour

donner un sens à l'information. Heureu-
sement, Calc vous fournit un moyen de
figer les lignes et les colonnes.

Pour figer une ou plusieurs lignes,
sélectionnez la ligne en dessous de celle
que vous voulez geler en cliquant sur le
numéro de la ligne, puis Fenêtre > Fixer.
Pour débloquer les lignes, sélectionnez à
nouveau Fenêtre > Fixer. La même chose
est à faire avec les colonnes en sélection-
nant la lettre de colonne à droite des
colonnes que vous voulez fixer, puis Fe-
nêtre > Fixer.

Pour fixer les deux - lignes et colon-
nes -, sélectionnez la cellule en dessous
des lignes que vous voulez geler et à
droite des colonnes que vous voulez
geler, puis sélectionnez Fenêtre > Fixer.

6. Partage d'écran

Une autre manière de travailler avec
de grandes feuilles est d'utiliser l'écran
partagé. Pour diviser l'écran horizontale-
ment, saisissez la barre épaisse juste au-

dessus de la barre d’ascenseur vertical.
Le curseur de la souris se transforme en
flèche double. Faites glisser la barre épaisse
jusqu'à la position que vous souhaitez. Pour
diviser l'écran verticalement, faites la même
chose avec la barre épaisse à la droite de la
barre de défilement horizontal. Pour
obtenir une scission rapide horizontale et
verticale, il suffit de sélectionner Fenêtre
> Scinder. Les partages sont représentés
par des lignes épaisses lourdes. Chaque
zone de l'écran partagé est manipulable

par de nouvelles barres d’ascenseur diffé-
rentes qui apparaissent.

Pour annuler la division d'un écran,
prenez la ligne épaisse et faites-la glisser
vers le sommet pour une division horizon-
tale ou vers la droite pour une division
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verticale. Pour annuler toutes les divisions,
utilisez Fenêtre > Scinder.

7. Imprimer les lignes et les
colonnes sur chaque page

L'impression d'une feuille qui se fera
sur plusieurs pages peut exiger des
informations essentielles dans certaines
rangées ou colonnes afin d'aider à donner
du sens aux données. Pour contrôler la
façon dont les pages sont imprimées,
vous pouvez définir si certaines lignes ou
colonnes doivent se répéter sur chaque
page.

Ouvrez Format > Zones d'impression >
Éditer. Dans la section « Lignes à répé-
ter », vous pouvez définir les lignes qui
ont besoin d'être répétées sur chaque
page. Par exemple, pour répéter les deux
premières rangées, il faut entrer $1:$2.
Sous « Colonnes à répéter », vous pouvez
faire la même chose pour les colonnes,
donc pour répéter la première colonne, il
faudra rentrer $A.

8. Remplissage des
cellules sélectionnées

Dans son utilisation la plus basique,
l'outil de remplissage est une façon de
répéter les informations dans une autre
cellule. Pour répéter l'information dans
cette cellule, sélectionnez les cellules
que vous souhaitez répéter, puis Edition
> Remplir >(la direction que vous voulez
remplir : gauche, droite, haut ou bas).

Mais la véritable puissance de l'outil
de remplissage vient de l'utilisation
de la série de remplissage. Edition >
Remplir > Série. L'outil de remplissage
en série vous permet de créer de nom-
breux types d'informations en série,
allant des nombres aux dates. Il y a
aussi le remplissage automatique, qui
utilise une série de textes prédéfinie
dans le programme. Des exemples de
la saisie automatique sont les jours de
la semaine et les mois. Vous pouvez
définir vos propres listes de saisie
automatique dans Outils > Options >
LibreOffice Calc > Listes de tri.

9. Liste de
sélection

La liste de sélection
est une fonction texte. La
liste de sélection ne fonc-
tionne que pour le texte
et ne contiendra que du
texte de la colonne ac-

tuelle où se trouve votre cellule sélec-
tionnée. Pour activer la liste, sélectionnez
une cellule vide et appuyez sur Alt +
Flèche vers le bas sur votre clavier.

10. Suppression de
données des cellules

Vous avez peut-être parfois besoin
de supprimer complètement les données
d'une cellule, plutôt que de les modifier.
La suppression des données peut se faire
en un seul coup, et vous pouvez sélection-

ner le type d'information qui sera effacé.
Par exemple, vous pouvez sélectionner
un groupe de cellules et choisir de ne
supprimer que la mise en forme, ou
seulement le texte. Il y a aussi un « Tout
Supprimer » pour supprimer toutes les
informations de la cellule. Vous activez la
boîte de dialogue « Supprimer du con-
tenu » en sélectionnant une ou plusieurs
cellules et en appuyant sur la touche
«  Retour arrière » de votre clavier. Vous
pouvez aussi le faire à travers les menus :
Édition > Supprimer du contenu.

Et voilà ! Vous les avez, mes dix meil-
leures astuces pour LibreOffice Calc.

Dans mon prochain article, nous
allons continuer notre voyage dans Calc
en apprenant à créer des diagrammes
et des graphiques.

TUTORIEL - LIBREOFFICE PARTIE 13
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Alors que la collecte de don-
nées est utile et aide à déter-
miner des résultats ou à savoir
si les objectifs ont été atteints,

les tableaux et graphiques simplifient
les données pour que les autres puissent
rapidement comprendre et interpréter
les résultats. Le côté artistique pour faire
des tableaux et des graphiques échap-
pe à la portée de cet article, mais je vais
vous montrer comment créer un graphique
dans Calc qui pourrait vous servir dans
Writer ou Impress. Il y a beaucoup de
tableaux et graphiques prédéfinis dispo-
nibles dans Calc. [Ndt : le terme utilisé
dans le menu de LibreOffice en français
est « Diagramme… »].

Nous allons utiliser un simple ensem-
ble de données pour créer notre tableau.
Les données représentent les locations
de bateaux pour une période de six
mois. Nous allons utiliser un graphique
(diagramme) à barres pour montrer la
relation entre les différents types de
locations de bateaux pour chaque mois.

L'Assistant de diagramme

L'assistant de diagramme nous per-
met d'obtenir les éléments de base de
notre tableau remplis rapidement et
facilement. En effet, parfois l'assistant

graphique rassemble tout ce dont vous
aurez besoin pour compléter votre ta-
bleau. L'assistant est votre point de
départ pour toute création de graphique.
Avant de lancer l'assistant, vous devez
sélectionner les données utilisées pour
le graphique. Assurez-vous que vous
venez de sélectionner les données et
leurs en-têtes. Bien que vous puissiez

modifier les plages de la série de don-
nées plus tard, les prendre le plus pré-
cisément possible aide Calc à mieux rendre
les résultats définitifs.

Vous avez deux façons de
démarrer l'assistant de dia-
gramme. Vous pouvez cliquer
sur l'icône Chart Wizard (Assis-

tant de diagramme) (voir ci-dessus) sur la
barre d'outils principale, ou par le menu
avecInsert>Chart(Insertion>Diagramme…).
L'assistant de diagramme est composé

de quatre étapes. Nous passerons en
revue chacune des étapes, mais il est
possible de cliquer sur le bouton Finish
(Terminer) à tout moment pour mettre
fin au processus de l'assistant.

1. Type du diagramme

Le type du diagramme (ci-dessus) est
l'endroit où vous sélectionnez le type
de graphique que vous souhaitez créer.
Pour certains types de graphiques, vous
avez la possibilité d'effets 3D et, pour
d'autres, non. Pour notre graphique, nous
allons sélectionner le graphique à barres
de base. Puisque nous avons la possibilité
d'effets 3D pour un graphique à barres,
nous allons également cocher la case
3D. Dans le menu déroulant 3D, vous
disposez des options Réaliste ou Simple.
Cela permet de déterminer l'apparence
et l'ombrage de l'effet 3D. Nous allons

utiliser Réaliste. Enfin, vous pouvez sélec-
tionner des formes différentes pour votre
série de données. Nous allons utiliser les
cylindres. Cliquez sur le bouton « Suivant »
pour passer à l'étape suivante.

2. Plage de données

Dans la deuxième étape, nous défi-
nissons la Plage de données et com-
ment Calc l'utilise pour créer le gra-
phique. Si nous avons besoin de chan-
ger la plage de ce que nous avons choisi,
nous pouvons soit entrer, soit sélec-
tionner, la plage dans la feuille de calcul.
Le petit bouton à la fin de la zone de
texte Plage de données va minimiser la
boîte de dialogue de l'assistant ; ainsi,
une plus grande partie de votre feuille
de calcul est visible.

Nous avons besoin de dire à Calc si
nos séries de données sont définies par
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ligne ou colonne. Pour notre exemple,
nous avons utilisé des colonnes. De
plus, puisque nous avons sélectionné
les en-têtes aussi bien que les données,
nous devons cocher à la fois First row as
label (Première ligne comme étiquette)
et First column as label (Première
colonne comme étiquette).

Cliquez sur le bouton «  Suivant  »
pour passer à l'étape suivante.

3. Séries de données

La troisième étape (ci-dessous) nous
permet de redéfinir, ajouter, modifier

l'ordre et supprimer des données de
nos séries de données. Vous verrez les
séries de données pour le graphique
définies par leurs étiquettes dans une
liste. Vous pouvez modifier la portée de
la série de la même façon que vous
pourriez l'avoir fait à l'étape plage de
données ; mais gardez à l'esprit que cela
ne s'applique qu'à un ensemble de
données et non pas à l'ensemble du
graphique. Vous pouvez ajouter une
autre série en cliquant sur le bouton
Add (Ajouter). Vous pouvez supprimer
une série en la sélectionnant et en cliquant
sur le bouton Remove (Supprimer). Mo-

difiez l'ordre des séries en sélectionnant
la série que vous souhaitez déplacer et en
utilisant les boutons fléchés haut et bas.

Nous n'avons pas besoin de chan-
ger quoi que ce soit ici, alors cliquez sur
le bouton Next (« Suivant ») pour passer
à la dernière étape de l'assistant.

4. Éléments du diagramme

La quatrième étape (en haut à droite)
de l'assistant nous permet de définir
des noms pour les différentes parties
de notre tableau, y compris le titre,
sous-titre et les axes x et y. Nous pou-
vons aussi définir l'emplacement de notre
légende et la grille de la zone graphique.
Pour notre exemple de graphique, lui
donner le titre « Exemple de dia-
gramme à barres ». Nous voulons aussi
étiqueter notre axe Y comme « Nombre
de locations ». Puisque notre axe X est
les mois de l'année, nous n'avons pas
vraiment besoin d'une étiquette pour
l'axe X. Il parle de lui-même. Positionnez

la légende dans la partie inférieure
(bottom), donnant à nos données plus
d'espace pour s'étaler.

Nous avons maintenant terminé
avec l'assistant graphique. Si jamais
vous avez besoin de revoir l'une des
étapes, vous pouvez utiliser le bouton
Back (Précédent) ou sélectionner l'étape
dans la liste sur la gauche. Cliquez sur le
bouton Finish (Terminer) pour terminer
l'assistant et afficher le graphique dans
votre feuille de calcul.

Formatage des éléments
du graphique

Après la création du graphique avec
l'assistant graphique, il est possible d'en
changer les éléments. Après avoir cliqué
sur Finish (Terminer), vous remarquerez
que le graphique nouvellement créé est
sélectionné et que votre barre d'outils a
changé. Vous avez la barre de forma-
tage graphique au lieu de la barre d'outils
d'édition standard. La nouvelle barre
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d'outils possède un menu déroulant qui
permet de sélectionner les différents
éléments que vous pouvez changer.
Après avoir sélectionné un élément
dans la liste déroulante, cliquez sur le
bouton Format Selection (Formater la
sélection) pour afficher la boîte de dia-
logue pour cet élément.

Il existe également des boutons per-
mettant de modifier le type de gra-
phique et d'afficher la grille graphique
et la légende. Le bouton avec la double
flèche à côté de la lettre A majuscule
est utilisé pour agrandir le texte avec le
graphique quand vous le redimension-
nez. Je recommande fortement ceci, car
il garde les choses proportionnelles. En
plus des changements dans la barre
d'outils, vous trouverez aussi des chan-
gements dans les menus Insert (Inser-
tion) et Format. Ces changements per-
mettent d'insérer et formater des élé-
ments de votre graphique.

Vous pouvez déplacer le graphique
en faisant un cliquer-déplacer sur les
bords. Redimensionnez le graphique en
faisant un cliquer-déplacer sur l'une des
huit poignées. Si vous avez sélectionné
le bouton échelle du texte, la taille du
texte sera ajustée en même temps que
le tableau lorsque vous le modifiez.

Maintenant, nous allons apporter
quelques modifications à notre tableau.
Dans la liste déroulante de la barre

d'outils, sélectionnez Chart Title (Titre)
et cliquez sur le bouton Formater la
sélection. Dans l'onglet Font (Police), modi-
fiez la taille à 18 et le style à bold (gras).
Cliquez sur OK. Ensuite, sélectionnez
Chart Area (Zone du diagramme), puis
cliquez sur Formater la sélection. La
zone graphique est tout le fond du ta-
bleau. Sous l'onglet Remplissage (Area),
sélectionnez une couleur de fond gris
clair. Vous remarquerez que cela change
la couleur de notre zone de données
aussi, mais nous voulons que la zone de
données se détache. Sélectionnez Dia-

gramme (Chart) à partir de la liste
déroulante et cliquez sur Formater la
sélection. Sous l'onglet Area (Remplis-
sage), sélectionnez Fill with color (Rem-
plir) et choisir blanc. Puisque nous
utilisons un graphique 3D, nous allons
changer un peu le point de vue : Format
> 3D View (Affichage 3D…), cochez la
case Perspective et modifiez le pour-
centage à 50 %. Vous verrez que la pers-
pective du graphique change.

Il y a d'autres choses à faire par
vous-même. Essayez de changer la
couleur de l'une des séries de données

ou de régler l'emplacement de certains
des éléments. Tout peut être fait par la
liste déroulante et les menus Format et
Insertion. Lorsque vous désélectionnez
le graphique, vous revenez à la barre
d'outils normale et les menus normaux.
Pour modifier le graphique plus tard, il
suffit de double-cliquer sur le graphique
et vous obtiendrez à nouveau la barre
d'outils et les menus spécialisés.

Nous n'avons fait qu'effleurer la sur-
face des graphiques dans Calc, mais je
vous encourage à jouer avec les diffé-
rents types et éléments. Le type de gra-
phique que vous utiliserez dépend du
type de données que vous avez et les
informations que vous voulez trans-
mettre.

La prochaine fois, nous allons com-
mencer notre travail dans Impress, le
programme de présentation de Libre-
Office.

TUTORIEL - LIBREOFFICE PARTIE 14



spécial libreoffice volume deux 21

TTUUTTOORRIIEELL
Écrit par Elmer Perry LLiibbrreeOOffffiiccee ppaarrttiiee1155 :: PPrréésseennttaattiioonn

P
résentation (Impress) est, com-
me son nom l'indique, le pro-
gramme de présentation de
LibreOffice ; c'est l'équivalent

de PowerPoint de Microsoft Office.
Avec Présentation, vous pouvez créer
des présentations visuelles incluant des
graphismes, des images, des vidéos, de
l'audio, des tableurs et des graphiques.
Présentation comporte un Assistant
Présentation qui est très utile pour
vous aider à configurer une nouvelle
présentation et vous faire démarrer
du bon pied. Sa fenêtre principale
vous aide à décomposer le processus
tâche par tâche.

L'Assistant présentation

Vous pouvez créer une nouvelle
présentation vierge en allant à Fichier
> Nouveau > Présentation. Cependant,
pour démarrer l'Assistant Présenta-
tion, cliquez sur Fichier > Assistants >
Présentation. Si vous voulez commen-
cer par l'assistant chaque fois que
vous créez une nouvelle présenta-
tion, vous pouvez l'activer. Pendant
que vous êtes dans Présentation, cli-
quez sur Outils > Options > Libre-
Office Impress > Général et cochez
«  Démarrer avec l'Assistant » sous

Nouveau document.

Le premier écran de l'assistant (à
droite) vous permet de choisir entre
une présentation vierge, un modèle
ou l'ouverture d'une présentation exis-
tante. Si vous choisissez « À partir
d'un modèle », il y a deux modèles par
défaut. Les deux viennent avec des
diapositives pré-définies. Je vous sug-
gère de cocher Aperçu, puisque ainsi
vous voyez à quoi ressemblera votre
présentation pendant sa création dans
l'assistant.

ASTUCE : Vous avez la possibilité à tout
moment dans l'assistant de cliquer
sur le bouton Créer pour créer une
nouvelle présentation. Cela vous permet
d'utiliser uniquement les parties de
l'assistant dont vous avez besoin.

Cliquez sur Suivant >> pour aller au
deuxième écran de l'assistant. Ici vous
pouvez choisir parmi beaucoup d'ar-
rière-plans de présentation. Vous pour-
rez changer l'arrière-plan des diapos
individuels plus tard, mais celui-ci
deviendra l'arrière-plan de base pour
votre présentation. Vous devrez aussi
sélectionner un média de sortie - nor-
malement écran - mais il y a d'autres
options disponibles si jamais vous en
avez besoin.

Cliquez sur Suivant >> pour avancer
jusqu'au troisième écran de l'assistant.
Ici, vous pouvez choisir une transition
entre les diapos. Il y a beaucoup d'effets

de transition différents parmi lesquels
choisir. Lorsque vous sélectionnez un
effet, vous en avez un aperçu dans la
fenêtre d'aperçu. Vous avez égale-
ment la possibilité d'ajuster la vitesse
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de la transition. Il vous sera possible
de changer l'effet de transition de
diapos individuelles plus tard, mais,
avec l'arrière-plan, la transition est
l'une des choses qui créent de la
cohérence dans votre présentation.
C'est ici aussi que vous pouvez sélec-
tionner le type de présentation. « Stan-
dard » fait avancer les éléments et
diapos en se servant de la souris ou
du clavier. « Automatique » vous permet
de régler la durée d'affichage et la
durée de pause des diapos. Ce choix
dépend de votre présentation et dé-
passe la portée de cet article.

Cliquez sur Suivant » pour aller au
quatrième écran de l'assistant [Ndt :
si vous utilisez un modèle, sinon, l'as-

sistant est terminé]. Ici, vous pouvez
donner le sujet, le nom de la société
(ou votre nom si la présentation n'est
pas pour une société), et les idées qui

sous-tendent la présentation. Ce que
vous mettrez s'affichera sur la pre-
mière diapo.

Cliquez sur Suivant » pour avancer
au cinquième écran de l'assistant. Si
vous avez sélectionné un modèle sur
le premier écran de l'assistant, vous
pouvez vous servir de cet écran pour
avoir un aperçu de chaque diapo après
vos modifications. Vous pouvez éga-
lement choisir si une diapo précise
sera incluse dans la présentation ou
pas. Cochez « Créer un sommaire »
pour créer un résumé des diapos.

ASTUCE : Vous pouvez toujours vous
servir du bouton << Précédent pour re-
tourner à un autre écran et modifier
des éléments de votre présentation.
Cliquez sur le bouton Créer et Pré-
sentation créera les diapositives pour
votre nouvelle présentation.

La fenêtre principale

La fenêtre principale de Présen-
tation (ci-dessus) est divisée en trois
sections, le volet Diapo, l'espace de
travail et le volet Tâches. Vous pou-
vez masquer les volets Diapo et
Tâches en cliquant sur le X dans le
coin supérieur de chacun. Pour mon-
trer les volets à nouveau, utilisez
Affichage > Volet Tâches ou Affi-
chage > Volet Diapo. Vous pouvez
aussi vous servir des marqueurs Mas-
quer (entourés de rouge dans l'image)
pour cacher et afficher les volets.

Le volet Diapo(rama)

Le volet Diapo affiche des minia-
tures de toutes les diapositives de
votre présentation dans l'ordre dans

laquelle elles apparaîtront. Ici, vous
pouvez ajouter, supprimer, copier, col-
ler, bouger, dupliquer, renommer ou
masquer des diapositives. Si vous cli-
quez sur une diapositive dans le volet
Diapo, elle sera placée dans l'espace
de travail où vous pouvez la modifier.

L'espace de travail

Comme son nom l'indique, l'espace
de travail est le volet où vous pouvez
modifier des diapositives. Il y a cinq
onglets de l'espace de travail.

Normal

Normal est l'espace où vous tra-
vaillez sur les diapositives une à une.
Ici, vous pouvez ajouter des images,
changer et ajouter du texte, des effets
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d'animation et plus encore.

Plan

Plan affiche le plan de tout le texte
dans les boîtes texte par défaut sur
chaque diapositive. Les diapositives sont
numérotées. L'affichage Plan vous per-
met de relire et modifier le texte figu-
rant dans les diapositives ou, encore,
y ajouter du texte. Les noms des diapo-
sitives ne sont pas inclus dans le plan.

Notes

Sous l'onglet Notes, vous pouvez
ajouter des notes à des diapositives
individuelles. Vous pouvez changer la
taille de la boîte de texte sous la dia-
positive en cliquant sur la bordure et
en déplaçant les poignées. Les notes
ne s'afficheront pas pendant votre pré-
sentation, mais vous pouvez les im-
primer afin de les utiliser pendant
celle-ci ou les distribuer au public cible
comme prospectus.

Prospectus

Sous l'onglet Prospectus, vous pou-
vez paramétrer l'impression de votre
prospectus. Si vous sélectionnez Mises
en pages dans le volet tâches, vous
pouvez régler le nombre de diaposi-
tives qui apparaîtront sur chaque page
du prospectus (jusqu'à 9 diapos par
page). Ici, vous avez la possibilité aussi

de choisir l'information qui sera im-
primée dans le prospectus.

Trieuse de diapositives

L'onglet Trieuse de diapositives
fonctionne de la même manière que
le volet Diapo, mais, ici, vous avez plus
d'espace pour travailler. Vous pouvez
ajouter, supprimer, déplacer, copier,
coller, dupliquer, renommer et masquer
les diapos. Vous pouvez également tra-
vailler avec un ensemble de diapositives
en en sélectionnant plusieurs.

Le volet Tâches

Le volet Tâches comporte 5 sections.
Cliquer sur le nom d'une section la
développera. Il n'est possible de déve-
lopper qu'une section à la fois.

Pages maîtresses

C'est ici que vous définissez le style
de la page pour votre présentation.
Présentation contient de nombreuses
pages maîtresses pré-définies que vous
pouvez utiliser. Au moyen de Styles,
vous pouvez changer l'apparence d'une
page maîtresse. Une présentation peut
avoir plus d'une page maîtresse, ce
qui vous permet d'utiliser plus d'un
seul style visuel au cours de la pré-
sentation.

Mises en pages

Les mises en pages proposées par
défaut s'affichent ici. Vous pouvez choi-
sir une mise en pages et l'utiliser telle
quelle ou la modifier. Il n'est malheureu-
sement pas possible de sauvegarder
des mises en pages personnalisées vers
les listes de mises en pages.

Ébauche de tableau

Des styles standards de tableau sont
montrés ici. Vous avez toujours l'option
de changer la mise en page et le ta-
bleau se comportera à peu près comme
un tableau dans Calc.

Animation personnalisée

Avec des animations personnali-
sées, vous pouvez régler quand et
comment des éléments s'affichent sur
les diapositives. Vous avez beaucoup
d'options diverses qui vous aideront à
créer les effets visuels dont vous avez
besoin pendant la présentation. N'exa-
gérez pas ici à moins d'avoir une
bonne raison de le faire. Alors que les
animations peuvent rendre votre
présentation intéressante et agréable
à voir, elles peuvent aussi lui donner
une apparence inappropriée et dérou-
tante. Cela dit, si vous avez besoin de
souligner un point précis, des anima-
tions personnalisées peuvent vous
aider à le faire.

Transition de diapo

La section Transition de diapo vous
permet de changer la façon dont une
diapositive remplace la précédente. Il
y a un grand choix de types de transi-
tions et de rapidité de transition. Si
vous choisissez « Passer à la diapo
suivante > Automatiquement après »,
vous pouvez contrôler la durée d'affi-
chage de la diapositive.

Cet article n'a été qu'un bref aperçu
pour vous permettre de commencer à
travailler avec Présentation. Je vous
suggère vivement de commencer à
jouer avec les affichages divers, les
sections et les mises en page afin de
mieux comprendre comment ils fonc-
tionnent et ce qu'ils vous permettent
de faire. La prochaine fois, nous allons
commencer à modifier des diapositives
et à y ajouter du texte et des gra-
phismes.

TUTORIEL - LIBREOFFICE P. 15 : PRÉSENTATION
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Une belle présentation com-
mence par une conception
des diapos agréable et bien
pensée. Vous avez égale-

ment besoin de cohérence entre vos
diapos, des éléments qui les relient.
Dans LibreOffice, vous pouvez utiliser
les pages maîtresses [Ndt : aussi ap-
pelées Masques et en anglais Master
Pages] pour créer le schéma de base
de votre présentation. Les pages maî-
tresses deviennent le cadre de l'ensem-
ble de la présentation, en en reliant
ensemble les éléments. Une grande
partie de ceci se fait au moyen des
styles et les pages maîtresses sont le
style principal. Ainsi, les pages maî-
tresses sont en quelque sorte équi-
valentesauxstylesdepagedansWriter.

Modifier les masques

Pour modifier les masques, vous
devez passer en Mode Masque. Ouvrez
le Mode Masque dans Affichage >
Masque > Masque des diapos. Ou
bien, vous pouvez faire un clic droit
sur la page maîtresse que vous sou-
haitez modifier dans la section Pages
maîtresses du volet Tâches, puis sélec-
tionnez Éditer le masque.

Lorsque vous entrez dans le mode
masque, la barre d'outils principale
s'affiche. Elle vous donne des options
particulières pour modifier les pages
maîtresses. Utilisez Ajouter pour ajou-
ter un nouveau masque. Supprimer
vous permet de supprimer le masque
sélectionné. Supprimer est grisé lorsque
vous n'avez qu'un seul masque, car

vous devez en avoir au moins un.
Renommer vous permet de renom-
mer le masque actuellement sélec-
tionné et « Fermer le mode masque »
termine la modification des pages
maîtresses.

Vous avez cinq zones prédéfinies
modifiables dans une page maitresse :

Zone de titre - La zone de titre
contient le titre de la diapositive. Con-
cevez-le comme le sujet de la diapo-
sitive.

Zone d'objet - La zone d'objet con-
tient les données de la diapositive,
que ce soit du texte, une image, un
graphique ou une table. Comme vous
le verrez, les données de la diapo ne
sont pas limitées à la zone d'objet.
Vous pouvez ajouter des éléments en
dehors de la zone d'objet, mais, en
règle générale c'est une bonne idée
de garder des données dans cette
zone pour la cohérence de votre pré-
sentation.

Date, Pied de page et Zone de
numérotation des diapos. Par défaut,
ces zones ne s'affichent pas sur la
diapositive même. Pour changer cela,
allez dans Affichage > En-tête et pied
de page et vous pouvez décider si oui
ou non ces objets apparaîtront sur les
diapositives.
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Modifier la page
maîtresse

Nous allons commencer par le
style par défaut de votre page maî-
tresse. Tout d'abord, nous allons chan-
ger l'arrière-plan. Format > Page. Sous
l'onglet Arrière-plan, utilisez le menu
déroulant et sélectionnez « Dégradé ».
Dans la liste des dégradés, choisissez
Radial rouge/jaune. Cliquez sur OK.
Cela vous donne un fond brillant et
ensoleillé pour travailler.

Ensuite, nous allons ajouter une
image à votre page maîtresse. L'image
apparaîtra sur toutes les diapositives
qui utilisent cette page maîtresse. J'ai
créé une frise contenant les icônes de
toutes les applications de LibreOffice.
Nous voulons qu'elle se place juste en
dessous de la zone d'objet. Insertion

> Image > À partir d'un fichier. Choisir
votre image et Ouvrir. Placez l'image
à la position que vous voulez, juste en
dessous de la zone d'objet. L'image
doit être centrée en bas. Faites un clic
droit sur l'image et choisissez Aligne-
ment > Centré. Vous voulez aussi que
l'image apparaisse derrière les objets
qui pourraient aller par dessus. Faites
un clic droit sur l'image à nouveau,
puis choisissez Organiser > Envoyer
vers l'arrière.

Maintenant, nous allons ajouter
une ligne sous le titre. Prenez l'outil «
Ligne » dans la barre d'outils de des-
sin en bas de la fenêtre et tirez un
trait sous la zone de titre. Vous pou-
vez changer le style de la ligne à l'aide
de la barre d'outils ligne. Changer le
style de la ligne, l'épaisseur, la couleur
et les styles des flèches de début et
de fin.

Enfin, nous allons modifier les zones
de date, de pied de page et de nu-
méro de page (ci-dessous). C'est dans
la page maîtresse que vous pouvez
modifier la taille et l'emplacement de
ces objets, mais vous pouvez en fait
les remplir avec un contenu à tout
moment. Affichage > En-tête et pied
de page. Sous l'onglet Diapo, il y a
une case à cocher pour chacune des
trois zones : la date, le pied de page
et le numéro de diapo.

Sous Date et heure, vous pouvez
choisir une date fixe ou une date
variable. Vous pouvez utiliser une date
fixe quand vous ne faites la pré-
sentation qu'une seule fois ou si vous
voulez que la date apparaisse d'une
manière non standard. Placez votre
texte de date dans la zone de texte à
côté de la case variable. Ce que vous
placez dans la zone de texte est ce
qui apparaîtra dans le champ date de
la diapositive. Utilisez la date variable
quand la date de la présentation est
inconnue ou si vous faites cette présen-
tation plus d'une fois. Variable placera
la date actuelle dans la zone de texte
Date. Avec la date variable, vous de-
vez sélectionner un format dans la
liste déroulante. Vous pouvez égale-
ment changer la langue.

Pour la zone de pied de page,
tapez le texte que vous voulez dans la

zone de texte de pied de page. Tout
ce que vous tapez dans la zone de
texte apparaît dans cette zone.

Il n'y a pas beaucoup d'options pour
le numéro de diapositive. Vous coche-
rez la case pour le montrer ou la déco-
cherez pour ne pas le montrer. Quand
il est coché, le numéro de la diapo-
sitive apparaîtra dans la zone numéro
de la diapositive.

REMARQUE : Les zones de date,
pied de page et numéro de diapo
sont désactivées sur la première diapo-
sitive, la page de titre.

Cliquez sur le bouton « Appliquer
partout » pour appliquer les paramètres
à toutes les diapositives à l'exception
de la page de titre. Cliquez sur le
bouton Appliquer pour l'appliquer seu-
lement à la diapositive en cours.

Styles d'Impress

Tout comme dans Writer et Calc,
Impress peut utiliser des styles pour
garder le tout uniforme. Ils sont éga-
lement un gain de temps. Cependant,
ils sont un peu différents dans Impress.
Impress n'a que deux types de styles
différents, présentation et graphique.

Un moyen simple de conceptua-
liser les styles de présentation est

http://eeperry.co.cc/resources/modules.png
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comme pour les styles des pages maî-
tresses. Vous avez des styles pour les
arrière-plans, les objets du fond, la
mise en valeur du texte, les notes, les
titres et sous-titres. Vous pouvez modi-
fier ces styles à souhait. Cependant,
vous ne pouvez pas créer de nouveaux
styles de présentation.

Les styles de graphiques sont des
styles pour les objets et les textes qui
ne sont pas directement liés aux pages
maîtresses. Vous pouvez modifier ces
styles comme vous voulez et vous
pouvez en créer de nouveaux.

La modification des styles se fait à
partir de la boîte de dialogue Styles et
formatage. Vous pouvez ouvrir la
fenêtre Styles et formatage en cli-
quant sur le bouton dans la barre
d'outils « Ligne et remplissage », en
appuyant sur la touche F11 du clavier
ou en allant sur Format > Styles et
formatage.

Faisons quelques modifications aux
styles de présentation pour montrer
comment ils fonctionnent. Tout d'abord,
passez en mode vue maîtresse, Affi-
chage > Masque > Masque des diapos,

et ouvrez la fenêtre Styles et forma-
tage, Format > Styles et formatage.
Faites un clic droit sur Titre dans la
boîte de dialogue et choisissez Modi-
fier. Sous l'onglet Police, sélectionnez
une police serif ou slab appropriée.
Mettez-la en gras, peut-être. Passez à
l'onglet Remplissage et changez le
remplissage à Dégradé. Choisissez le
premier dégradé dans la liste (noir
vers blanc). Dans l'onglet transpa-
rence, changez le mode à Transparence
et le pourcentage à 50 %. Cliquez sur
OK et vous verrez que la police pour
le titre a changé et qu'il a un fond
dégradé semi-transparent.

Maintenant, sélectionnez Plan 1
dans le dialogue Styles et formatage.
Faites un clic droit et modifiez-le. Tout
ce que nous voulons faire ici, c'est de
changer la police. Cliquez sur OK. Reve-
nez vers la page maîtresse et vous
remarquerez que la police est modifiée
pour tous les niveaux hiérarchiques.
C'est parce que chacun des niveaux
hiérarchiques est lié au précédent. Vous
ne pouvez pas changer ce lien, mais
vous pouvez modifier chacun des ni-
veaux pour qu'ils soient différents.
Cet effet de cascade peut être utile,
surtout avec la police pour aider à
créer l'uniformité.

Dans ce tutoriel, nous avons appris
à créer et modifier des masques dans

Impress. Les masques sont essentiels
pour aider à créer une cohérence
dans votre présentation. Nous avons
également examiné les styles de pré-
sentation et comment ils aident à
créer le style de vos diapositives. Je vous
encourage à jouer avec les para-
mètres des masques et les styles de
présentation. Les styles de présentation
ont 14 onglets différents, ce qui les
rend très souples. Vous pouvez créer
une présentation très professionnelle
et visuellement attrayante avec ces
outils.

La prochaine fois, nous commen-
cerons à travailler avec des diapo-
sitives individuelles.
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